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Abstract

Corelyzer isascalable, extensiblevisualization tool devel oped to enhancethe study of geological cores. The strength of
Corelyzer isthe ability to display large sets of core imagery, with multi-sensor logs, annotations and plugin supported
visuas alongside the core imagery. This document describes how to download, setup and use the software.
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About CoreWall

The CoreWall Suite is a collaborative development for a real-time stratigraphic correlation, core
description (CD) and data visualization system to be used by the marine, terrestrial and Antarctic science
communities. The development will be carried out in broad collaborati on with stakehol dersin these science
communities.

To ensure that the software development does not occur independent of related I T activities, in particular,
the development of the U.S. IODP-Phase 2 Scientific Ocean Drilling Vessel (SODV), a Steering
Committee will be congtituted. The Steering Committee will be comprised of key U.S. IODP and related
database (e.g., CHRONOS, SedDB) developers and users as well as representatives of other core-based
enterprises (e.g., ANDRILL, ICDP, LacCore). Data will be made available directly from the numerous
hard rock and sediment databases or through access provided by a portal such as CHRONOS. CoreWall's
software displays section images from one or more cores along with discrete data streams and nested
imagesto provide arobust approach to the description of sediment cores. Split-core surfaceimages arethe
fundamental template of sediment descriptive work. Loaded horizontally and viewed in high resolution
along a dliding plane, features such as lithologic variation, macroscopic grain size variation, bioturbation
intensity, chemical composition and micropal eontology are easier to interpret and annotate.

In particular, the CoreWall Suite will incorporate the new Correlator software, the updated version of
CLIP (e.g.,Sagan and Splicer) that was developed by the Lamont group more than 10 years ago, into
a new portable visualization tool that will work across multiple platforms and interact seamlessly with
both JANUS (ODP's relational database), CHRONOS, PetDB, SedDB, dbSEABED and other databases.
This functionality will result in a CoreWall Suite module that can be used and distributed anywhere for
stratigraphic and age correlation tasks. The versatility and flexibility of these enhanced software toolswill
allow geoscientists to integrate shipboard data entered into the JANUS database with 3rd party analyses
of samples distributed to other scientists or generated by other programs and projects. While doing this,
we will abstract the functional algorithms that drive NCLIP into software libraries that will be used in
the CoreWall Suite so that they are available for other software development projects that want to build
on these modules. In thisway, the critical depth mapping functionality and enhancements that resulted in
NCLIPwill beintegrated into the remarkabl e visualization capability that isCoreWall, which isenvisioned
to be at the heart of a next-generation suite of tools required by the |ODP and other ocean science research
programs, aswell as ICDP and other terrestrial core-based research programs.

CoreWall's high-resolution tiled LCD display gives geoscientists a large-scale perspective, helpful in
processing and comparing high-resolution digital line-scan images of cores measuring up to hundreds of
feet long. A prototype desktop environment for CoreWall is Personal GeoWall2 (PG2) , a system that uses
asingle computer to drive four LCD panels as well as a single-screen stereo GeoWall display.

CoreWall Affiliate Partners

Oceanleadership Consortium

USIO Science Services, TAMU: Integrated Ocean Drilling Program at Texas A & M University
CHRONOS

ANDRILL: Antarctic Geological Drilling Program

LacCore: U.S. National Lacustrine Core Repository at University of Minnesota

Electronic Visuaization Laboratory, University of Illinois at Chicago

Corelyzer isbeing devel oped by the University of Illinoisat Chicago’ sElectronic Visualization Laboratory
with funding provided by the National Science Foundation under the agreement number OCE-0602121.
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Figure 5. CoreWall Logo
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Chapter 1. Pre-installation
Requirements

1.1. Hardware

Corelyzer takes advantage of hardware-accelerated graphics. While aprimarily 2D visualization program,
Corelyzer uses OpenGL to accelerate the rendering and take advantage of modern day graphics boards.
This does mean that the performance of the application isnot only dependent on the speed of your CPU but
also the power of your Graphics Processing Unit (GPU). Any modern day graphics card that can run video
games from afew years back can easily run Corelyzer. Currently the leadersin graphics card technol ogies
are Nvidiaand ATI.

Corelyzer can use lots of hard drive space and main memory. It is recommended to have at least 2GB
of RAM on your machine if you intend on looking at a hundred meters of high-resolution core images,
or more. One more thing to note is that Corelyzer does not currently have any mechanisms to support
heterogeneous display settings. Thismeansthat if you have amonitor that only goes up to 1280x1024 and
another at 1600x1200, you will have to choose one or the other when setting up your Corelyzer display
settings when running the application.

1.2. Example Hardware Setups

1.2.1.

Thekey for CoreWall islarge screens and a good graphics card. We would suggest eith the Dell or Apple
30" LCD monitors. Andin order to drive each 30" monitor, you will need graphics cardswith a"dual-link"
DV port. If youintend to use 2 30" monitors, then you will need "dual-dual-link" ports. Possible selections
(but may not limite to) are ATI Radeon X1900 XT and NVIDIA Quadro FX 4500 cards. Following are
some CoreWall setups out there. Each contact islisted. If you need more information please contact each
indiviuals or Julian Yu-Chung Chen<j ul i an at evl . ui c. edu>.

ANDRILL - Antarctica Geological Drilling

ANDRILL's CoreWall Hardware Spec: an Apple Mac Pro with nVidia Quadro FX 4500 graphics card. 2
30" Apple Cinema Displays. Contact: Josh Reed <j areed at andrill.org>
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Figure1.1. ANDRILL CoreWall Setup

1.2.2. Electronic Visualization Laboratory, University of
lllinois at Chicago

EVL's CoreWall Hardware Spec: a Dell Pentium 4 XPS PC with 3 PCI nVidia Quadro FX500 graphics
cards. 520" ViewSonic LCD Displays. Contact: Julian Yu-Chung Chen<j ul i an at evl . ui c. edu>
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Figure 1.2. EVL CoreWall Setup

1.2.3. National Lacustrine Core Repository, University of
Minnesota

LacCore's CoreWall Hardware Spec: a PC (customiz-built Reason / Athlon 64 X2 Dual Core Processor
4200+, 2.21GHz, 3.25G RAM, 1TB HD) with NVIDIA GeForce 7900 GTX (512MB RAM). 1 30" Dell
LCD Display. Contact: Anders Noren <nor en021 at umm. edu>
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Figure 1.3. LacCore CoreWall Setup

1.2.4. Lamont-Doherty Earth Observatory, the Earth
Institute at Columbia University

LDEQO's CoreWall Hardware Spec: a Mac Pro with 4 nVidia GeForce 7300 GT graphics cards. 6 Apple
23" Cinema Displays. More Information [http://corelyzer.blogspot.com/2007/10/Ideo-corewall-setup-
details.html] Contact: Sean Higgins<sean at | deo. col unbi a. edu>
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Figure 1.4. LDEO CoreWall Setup

1.3. Software

Corelyzer, starting from version 0.6 makes use of the Java Runtime Environment (JRE). The current
version of Corelyzer requires Java Runtime Environment above version 1.5.0. Please make sure to install
Java 1.5.

For Microsoft Windows users, Corelyzer will bundle a copy of JRE within the downloaded package. Y ou
should not have to install JRE separately.

For Mac users, inthe current Mac OS X Leopard, Javaisbundled with the operating system. In some cases
of Mac OS X Tiger installation, Java 1.4 might be still presented in the system. In that case, you will have
to modify the default version to version 1.5.




Pre-installation Requirements

Figure 1.5. Setup default Java version in Mac OS X
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Chapter 2. Download and Install
Corelyzer

2.1. Download Corelyzer

You can download copies of the application for the following platforms at the main download
page: http://www.evl.uic.edu/cavern/corewall/downloads.php [http://www.evl.uic.edu/cavern/corewall/
downloads.php].

2.2. Install Corelyzer

2.2.1. Microsoft Windows Users

We provide an installer program for Windows users. Please download the installer .exe file from the
download page [ http://www.evl.uic.edu/cavern/corewal l/downl oads.php],, double click theicon and follow
the installer instructions.
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Download and Install Corelyzer

Figure 2.1. Corelyzer Windows I nstaller
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2.2.2. Apple Mac OS X Users

If you use Safari browser, the application should be downloaded and extracted in your "Downloads"
directory. If you use other browsers, please unzip the downloaded file (double-click it) and you will get
the application.

Y ou can drag-and-drop the application in your preferred disk location like the “/Applications’ directory
or even your Desktop. Double click the icon will launch the Corelyzer program.
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Figure2.2. Corelyzer in Mac OS X
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Chapter 3. Start Corelyzer

3.1. Setting up the desktop environment

Before we start Corelyzer, we must first make sure our display settings are correct. On both the Mac and
Windows, the default monitor should be the “upper left most monitor”.

3.1.1. Microsoft Windows Users

To setup the monitors on windows, you must first go to your "Display". Y ou can do this by going to your
Start menu, selecting "Control Panel" and double-clicking on "Display”.

10
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Figure 3.1. Display in Control Panel
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Once opened, please go to the Settingstab. Here you will see boxeswith numbers, and below those options
that can be adjusted. The boxes with numbers represent your monitors that you have connected to your
machine. If you have amonitor that isnot displaying your desktop then it will show up asaslightly grayed-
out box, which isavisual description that says this monitor is disabled. If the box indicates the monitor is
disabled and you click on the box, you will be able to modify the options for that monitor. To enabled the
monitor, make sure that the check box next to Extend my desktop... ischecked. Do thisfor all the monitors
you would liketo use, presumably all of them. Once you have done that, click on the Apply button. If you
did this correctly, you will have your desktop visible on all the monitors.
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Figure 3.2. Display
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Note: Some monitors need to be turned off and on again to realize that they are enabled by Windows.
Now that the desktops are visible on your monitors, you will need to set the display resolution for al of
the monitors. Corelyzer requires that you set your display settings so that all the monitorss will have the
same resolution. Example resolutions are 1280x1024 and 1600x1200. There is a slider on your display
settings dialog to modify the resolution. Once set for all monitors, click on the Apply button again. If you
are prompted to restart your machine in order for the changes to take affect, then do so. Otherwise, the
resolution of your monitorswill change and you will be prompted to keep the settings or change them back.

Note: If your monitors do not support a particular resolution they will likely display that or they will stay
black. If you do not like your settings, wait for some time and Windows will revert back. After you have
enabled your monitors and configured their display settings, you should make sure that the layout of the
monitors matches the layout of the boxes in your display settings. First we need to identify which box
represents which monitor, and we can do this by seeing what number has been assigned to each monitor by
Windows. To do this, click on the Identify button. When you do this, your monitorswill display a number
indicating which box refers to which monitor. If your monitors are ordered differently than the boxes that
are shown on your display settings, then you will need to re-arrange your monitors. Thisis easily done by
clicking and dragging the boxes in your settings window. Again, you should make sure that the upper left
most box matches with your upper left most monitor and that monitor is enabled as your Primary Monitor.

Note that the desktop numbering in Microsoft Windows is depending on the order of how you connect
monitors to graphic card connectors. It may not appear in ascending order from left to right. All you have
to make sure is the ordering is matched in the onscreen identify result and the display properties display,
as shown in the following two screenshots.

Figure 3.3. Example desktop configuration
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Figure 3.4. Arrange desktops with drag-and-drop
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3.1.2. Apple Mac OS X Users

To setup your monitors on your Mac you will need to get to the display settings. To do this, open the
"System Preferences” applicationin your "/Applications' directory. Then choose "Displays' and you will
see adialog window on each monitor that is connected to your machine.
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Figure 3.5. Displays setup in System Preferences
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Make sure the display resolution on each monitor isthe same. After fixing the resolution, go to your main
window and select the "Arrangement” tab. You will then see a layout of boxes that indicate how your
monitors are laid out. Unfortunately there is no way to identify which monitor is represented by which
box, as you can on Windows. Y ou will need to arrange the boxes to match your monitor arrangement.

You will have to make sure the upper left most monitor in your arrangement will be the main monitor.
On the Mac, the main monitor isvisible in the Arrangement tab as the box that contains awhite rectangle
along the top of the box. To designate a different monitor to be the main monitor, simply drag the white

rectangle to the box that should be the main monitor. This white rectangle is actually the menu bar you
see on top of your monitor. Once the rectangle has been moved, the menu bar will also move.

Figure 3.6. Arrangetab in Displays setting
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To rearrange the displays, drag them to the desired position.
To relocate the menu bar, drag it to a different display.

Menu bar at upper-left
monitor

Mirror Displays Disabled.
//’
A

irror Displays

If you are making a presentation then you may want to mirror your display, but normally you don't want
to mirror your display so that you will have more screen real estate to view your core images and data.
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3.2. Corelyzer Preferences

To start Corelyzer double click on the Corelyzer icon. If you start up Corelyzer for the first time, a
preferences configuration window will show up. The window isthe Corelyzer Preferences window. Using
this preferences window you can specify your scratch disk location, display settings, and some user
interface features.

Figure 3.7. Corelyzer Preferences Window
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3.2.1. Directories Panel

Corelyzer will use part of your hard disk to store pre-processed different level s of imagery blocks. Also, for
someimagesthat are not availablein user’ smachine, but their URL sare provided, Corelyzer can download
them to the download directory specified here. It is recommended to select a bigger and fast hard disk.
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Figure 3.8. Directories preferences
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3.2.2. Display Preferences

Here you can set the display configuration that Corelyzer will use. More often than not you will have it
match the display configuration you setup with your operating system (See above sections). The Display
Configuration window will store your settings. Once you have set this up the first time, Corelyzer will
load the saved configurations every time after without popping up the preferences window.

Rows, Columns: define how many monitors do you have and how they are arranged.

Screen Width, Screen Height: define the size of a single monitor in pixels. If you start the Preferences
configuration for the first time, the full screen dimension will be used.

Screen DPI X, Screen DPI Y: DPI stands for "dots per inch”. These defines the mapping from pixelsto
physical measurement. In most cases, you can leave them as default values.

Column Offset, Row Offset: Defines the offsets of the visualization area from the origin (upper-left
corner of the primary monitor).
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¢ Border Tickness: The visualization takesinto account the monitor border in tiled displays setup. In most
cases, you can |leave them with the default values.

Figure 3.9. Display Preferences
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3.2.3. User Interface Preferences

e Auto check version in startup: if the program automatically check for latest update in startup.

¢ Lock core section image: if the program will make loaded section image stationary (user can not move
it to arbitrary depths).

¢ Use Quaqua: if the program will use "Quagua" library to make the user interface components more
Mac-like (only for Mac).

¢ Double clicks to zoom to section: if zoom in/out with double click.
¢ Graph auto-scale: if the plotting graphs automatically scale during zoom in and zoom out.

¢ Annotation icon auto-scale: if the annotation icons automatically scale during zoom in and zoom out.

21



Start Corelyzer

» Show origin axis: if show the visualization origin axis.
» Show section labels: if show the section label if no images are available (with loaded graphs).
» Canvas Always Below: if the visualization area always below all external applications on the desktop.

* Depth-scroll in vertical depth mode: if the mouse wheel action interpreted as scroll along the depth
instead of default zoom infout action when the depth mode is set to "vertical".

» Horizontal or Vertica Depth: defines the depth orientation. The depth is defined from left to right
(deeper) by default (horizontal depth). If "Vertical Depth” is selected, the depth will mean from top to
below (deeper).

 Canvas background color: defines the background color of the visualization canvas.

» Canvasgrid: enable/disable and defines the background measurement grid parameters. In"Grid Type",
5 types of grid are supported: Basic Cross, Horizontal Lines, Vertical Lines, Points and Cross Points.

Figure 3.10. User interface preferences
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3.2.4. Session Sharing and DIS Preferences

These 2 preference tabs customize functions for session sharing and default annotation dictionary
definition. Y ou can use the default values.
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Chapter 4. Corelyzer Layout

Once'OK’ buttonisclicked in theinitial preferences configuration, awindow (or multiple windows) will
be created, according to your configuration, for the visualization display.

Figure4.1. Initial Corelyzer screen

And main Corelyzer layout can be divided in the following sections.
1. Tools palette
2. iCores control window

3. Visualization canvas
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4.1. Tools Palette

Figure4.2. Tool Palette Functions
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Tool Palette contains often used functions and modes. In multiple monitors setup, the Tool Palette will
follow the cursor moving from one monitor to another.

The functionslisted in the Tool Palette, from left to right.
Interaction mode:

* Normal mode: Use drag-and-drop mouse gesture to pan and the mouse scroll wheel to zoom/out the
visualization area.

« Create annotation mode: Crop arectangle area to create annotation over |oaded core images.

» Modify annotation marker mode: Select and highlight a created annotation to modify circled area and
the annotation flag icon's position.

» Measure mode: To specify the start and end of an interested segment. The physical measurement
will be calculated based on the mapping information specified in the Display settings of Preferences
configuration.

Cursor type:

» Regular navigation cursor: Only the mouse cursor will be shown when moving in the visualization
canvas area.

» CrossHair cursor: In additional to the mouse cursor, a crosshair will be shown when mvoing in the
visualization canvas area.

Common system actions:
» Show/Hide main window: Show or hide the main iCores control window.
e Minimize Corelyzer: Minimize all Corelyzer layout components.

* Quit Corelyzer: Close Corelyzer application.

4.2. 1Cores control window

The main iCores control window will be used to do major data management and accessing.
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4.2.1. Menus

Themenubar has"File", "Edit", "Share", "Plugins’, "Lists", "Tools" and "Help" menus. Each menu options
will be described in the actions in later chapters.

4.2.2. Local (status)

Clickonthe"Loca" label inthe"My Core Repository" panel will show the main panel that containscurrent
loaded "Session", "Track", "Sections', "Data Files' and "Data Fields'. In current hierarchy architecture,
Corelyzer can have multiple sessions. Each "session" can have multiple "tracks' and "data files'. Each
track can have multiple "sections' and each "datafiles' could have more than one data "fields".

Figure 4.3. iCores control window
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4.2.3. Subscriptions

Corelyzer supports core data list syndication (CoreCast) via Atom feeds. If you subscribed to feeds, they
will be attached to the "Subscription” label in "My Core Repository". Click on the subscribed feed entry
will show the core summary in the right hand panel.
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Figure4.4. iCoresfeed window
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4.3. Visualization canvas

Thisisthe main area showing core data visualization.
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Figure 4.5. Visualization canvas with loaded core data

A screen capture video of start and quit Corelyzer can be found in thislink online (size: 1.2MB) [http://
www.evl.uic.edu/cavern/corewal l/documents/movies/3.1-StartAndQuit.mov].
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Chapter 5. Load Images

Corelyzer by default visualizes core imagery by placing the image on a horizontal track. A track isjust
away of grouping multiple section images. Before you can load an image in Corelyzer, you must first
create atrack. To create atrack you must select the menu "File -> Create a Track”, after which you will
be prompted to enter a name for atrack. Once you do this the Track listbox in the main menu will update.

Figure5.1. Createatrack
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Tracksareaway of grouping. Sincewe have nothing in our grouping/track then nothing in our visualization
window will change. Now we add images so that way we can see something and have something to interact
with. Firgt, let's remember that our track is a horizontally oriented track, with an increasing depth as we
go from left to right. This means we will need images that are horizontally oriented in such a way that
they are increasing in depth from left to right.

IODPimagesarevertical, with increasing depth asyou go from top to bottom. Fortunately we have created
a Corelyzer Plugin that makes use of CHRONOS webservices to access the JANUS database. The plugin
is caled the "Chronos-Janus Plugin" and will be discussed later. For now, we will assume that there are
some images of core sections that are horizontally oriented, with an increasing depth from left to right.

If you know the images' orientation, you can also specify that individually in the image loading dialog
shown below.

We also have to make sure that your images have the correct dots-per-inch (DPI). Why does the DPI of
the image matter? This is discussed in detail in the appendix. It basically establish the correct mapping
between the image dimension to the physical core dimensions.

How do you know what is the right DPI of your image? This al depends on the equipment in which
the image was retrieved. Usually most line-scan cameras that are manufactured for the creations of high-
resolution digital line scan images of core sections have thisindicated in the advertisements of the scanner.
Unfortunately, it seemsthat most of the scanners don't save off the correct DPI. Thereisaquick and dirty
way of checking and making sure the DPI is correct in the section Making Sure the DPI of an Image is
Correct. Or in the image loading dialog below, you can also specify the core section image's length, the
DPI values will be calculated by Corelyzer.
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5.1. Load Images from local files

So now we will assume that the images are:
» Horizontally oriented
» Have anincreasing depth from left to right

» Havethe correct dots-per-inch (DPI)

To bring up the file selection dialog to tell Corelyzer which images to load, we need to first select the

grouping track in the track list, and then select the menu item "File -> Open Image Files...".

The “Load Images’ dialog will pop up and allow you to load the section images with properties like,
orientation (vertical or horizontal), length, DPI, and starting depth (in meters) of the section image etc.
The upper-right of the dialog is an Excel-like table. Click on the "Select Image Files" button to fill the
table with core section images. Y ou can double-click each cell to make individual modifications. Press
"Enter" when you finish editing a cell. Note that if you leavethe DPI_X and DPI_Y vaue as 0, the length

value will be used with image dimensions to calculate DPI values.

Also, you can enable the "Batch input” checkbox to fill the table parameters. Y ou can select orientation,
length, DPI, and start depth and depth increment. Click on "Apply" button will update and fill specified

parameters into the table above.

Click “OK” button when you are satisfied with the table content. Corelyzer will start loading selected

images with specified parameters.

Figure5.2. Load | mages dialog
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Once completed the visualization window will display our imagery, and the Section listbox in the main
iCores control window will update with the image filenames loaded on the Track. Notice in the image
below that our image hasaruler init, and that theruler in theimage closely matchesthe markersindicating
depth at the bottom of the visualization window.

Figure 5.3. Visualization canvas with loaded cor e section images

A screen capture video of these actions can be found in this link online (size: 3.5MB) [http://
www.evl.uic.edu/cavern/corewall/documents/movies/5.1-L oadL ocal Images.mov].

5.2. Load Images from online services

Corelyzer wasbuilt-in asimpleinterface to access online coreimage serviceslikethe |ODP Janus database
and IODP LIMS service to retrieve the high-resolution core section images.

In current version, Corelyzer supports 3 online core image services: JANUS database with CHRONOS
service, IODP LIMS on-shore database and IODP LIMS on-ship database. For 2 IODP LIMS services,
the query web service protocol was used to retrieve coreimage's metadata. Corelyzer usesthe CHRONOS
webservices capabilities to access JANUS and retrieve the URLS to the images. Corelyzer will rotate
the images 90 degrees counter-clockwise, because all the IODP images are vertically oriented, where
Corelyzer displays data horizontally. This plugin accuratly position the core sections using CHRONOS
web service to access the curated length and top depth (mbsf) of each core section image.

The user interface has been designed in a stream-lined manner. To bring up the plugin select the menu
item File->"Show IODP lists..."->"Image list from services' tab. Here are the steps to get image listing
and load selected images:

1. Select which online service to use. Currently CHRONOS, on-shore LIMS and on-ship LIMS services
are available.
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Load Images

2. Enter an IODP site to search for (e.g. site number 1215)

3. Click on the Search button. A listing of core section images should become available

4. You can optionally input the depth range to filter the returned available image section in the result
table. Depth range should be input as string like "0-20", meaning only list image section of top depth
from O meter to 20 meters (mbsf). The default value 0.0 will list al image sections returned by the
online service.

5. Select the images to load

6. Click on the "Load selected image files' button

7. User must wait as image files are retrieved over the web, processed and displayed. A progress bar
indicating the status will update during the process in the main window.

Each loaded image will beloaded and placed in the seesion and track named with the combination of "leg",
"site", "hole" and "core" metadata information from the online core image server.

Figure 5.4. Online coreimage service query interface
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Figure 5.5. Online coreimage service query
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A screen capture video of these actions can be found in this link online (size: 1.6MB) [http://
www.evl.uic.edu/cavern/corewall/documents/movies/5.2-L oadJanusl mages.mov].

5.3. Load Images from CoreCast syndication
feeds

Corelyzer supports core data list syndication (CoreCast) via Atom feeds. If you subscribed to feeds, they
will be attached to the " Subscription” label in "My Core Repository".

5.3.1. Subscribe to CoreCast feeds

First show the iCores control window if it is not on the desktop. Then click on the plus icon to add a
new feed.
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Figure5.6. Add a new feed
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If you know the feed URL, just copy-paste the URL string in the popup dialog. Otherwise, you can click
on the "Browse" button to list available feeds.

Figure5.7. Specify feed URL
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Here the "Browse" button is clicked. Next click on the "Refresh” button to show available feeds.
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Figure 5.8. Refresh availablelists
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Check the feeds interested then click on "OK" to subscribe to selected feeds. These feeds will be added
to the main iCores control window. Click on the feed entries under " Subscription” label will show the list
of core images in the feed. Click on a core image entry above will show a summary report of the image

at the panel below.
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Figure 5.9. Select to subscribe feeds
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5.3.2. Load core images from CoreCast feeds

Select one or more interested core images and use mouse right-click to see available options.
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Figure 5.10. Select coreimage entries and right-click
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Select "Load" to download and |oad selected coreimagesinto Corelyzer. Select or fill in the intented track
name for these selected core images.
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Figure5.11. Specify atrack to hold selected coreimages

Select a Track

SAFOD hole G

Cancel E

Click on "OK" will start the download and load process. Click on the "Local" labdl at the left hand side
to see if the selected sections are loaded.
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Figure 5.12. Images loaded with iCores feeds
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A screen capture video of these actions can be found in this link online (size: 10MB) [http://
www.evl.uic.edu/cavern/corewall/documents/movies/5.3-L oadCoreCastl mages.mov].

5.4. Load images using IODP-formatted section

list

Click on the meun "File" -> "IODP" -> "Load section list" and select a section list file in format like
examplefile[attachments/holeB.dat] (remoteimagefiles) and examplefile[attachments/A-mac.txt] (loca
image files) will load and show the content of the list as shown in the following screen captures.

The section list file can be generated by any text editor or Excel. You will have to save the file as "tab-
separated format". Thefile will need to include columnsin order including: "Leg", "Site", "Hol€", "Core",
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"Type", "Section", "TopOffset", "BottomOffset”, "Depth", "Imagel ength" and "imagefile's source URL".
Currently the "TopOffset" and "BottomOffset" are not really used. Y ou can just fill in default value 0.0.

Use mouse or keyboard to highlight the section that you want to load, and click on the "Load selected
section" button at the bottom will initial section images downloading and loading into Corelyzer.

Figure 5.13. Select load section list in IODP menu
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5.5. Load FMS images from IODP-USIO logging
database

The Integrated Ocean Drilling Program, United States Implementing Organization provides the
logging database accessing service described in the webpage [http://brg.Ideo.columbia.edu/services/].
The service serves not only numerical data but also some Formation MicroScanner (FMS) [http://
www.ldeo.columbia.edu/BRG/ODP/LOGGING/TOOL S/fms.html] represented in image form stored in
GIF format.

Toload FM Simages from the IODP-USI O logging database, select the"lIODP" meun item from the "File"
menu and then select "Show IODP lists...". Then clicking on the "Logging DB" tab in the popup window
as shown in the following figure.
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Figure5.15. Logging DB tab in IODP tables window
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Then depending on where do you run the program, you can choose to access the on-ship version
or the Internet version of the service. On-ship version will use the service provider URL "http://
loa.ship.iodp.tamu.edu/serviced [http://load.ship.iodp.tamu.edu/services]" and the Internet version will
use the service provider URL "http://brg.ldeo.columbia.edu/ [http://brg.ldeo.columbia.edu/services/]".
Oncethe service provider is selected, the available site and tool optionswill be downloaded and popul ated
in the selectable combobox options. Or you can aso type in interested site and tool and then click on the
"Search" button to search for available data. The search result will be shown in the table rows below. Y ou
can use mouse to highlight multiple rows and click on the "Load selected datafiles" button to download
and load the data/image files.
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For FMS images, since the depth and length information is not directly available. Corelyzer will
attempt to load these images by guessing from their file name. For example a FM S image file named
"306-642E_p2 D 372 _442.gif" will be parsed and implies that the FM'S image will contain data from
372 to 442 meters. Corelyzer will use these 2 values to determine the depth and length of the interval of
interest. But users should be aware that the FM S images are not cropped to the exact range, and there are
white space form borders around the image, so the estimatation may not be accurate. If you want further
finer adjustment could be adjusted in the images' properties dialog.

A screen capturevideo of these actions can befoundinthislink online (size: 6M B in 1920x1200 resol ution)
[http://www.evl.uic.edu/cavern/corewall/documents/movies/L oadFromL oggingDB.mov].
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Chapter 6. Load and Plot Numerical
Log Data

6.1. Native Corelyzer XML Format Dataset Files

Corelyzer loads data using the Corelyzer data XML schema (see appendix). A Corelyzer XML format
datset file can contain multiple fields in a single file. Data files can be loaded at anytime during the
execution of the program. To do so you will need to choose the menu item under "File -> Open Dataset
Files' and afile selection dialog will appear. Corelyzer data files are in XML and properly have a .xml
extension appended to them.

Once a data file is selected, the Corelyzer application will process the data and then update the Dataset
and Fieldslist boxes (click onthe"Local" label in "My Core Repository” to show thelists). If you load up
multiple datafiles, you can click on a dataset to view what fields were retrieved from the datafile.

A screen capture video of these actions can be found in this link online (size: 868KB) [http://
www.evl.uic.edu/cavern/corewall/documents/movies/6.1-L oadNativeData.mov].

6.2. Use Quick Data Import

In many cases, numerical data are alist of depth-value pairs for a single property. Use the "Quick Data
Import" function, you can import data files that can be easily edited or generated by external programs
like spreadsheet or even raw text data files generated by multiple sensor core loggers. The "Quick Data
Import" function will accept plain text files that follows the format described below.

The plain text file should be in tsv (Tab-Separated-Vaues) or csv (Comma-Separated-Vaues) formats
(filename ended with .csv or .tsv). The first line of the file will describe the meaning of the values and
its contents will also be used for datafield labels. The rest of the file should be one depth with multiple
values per line. And example .tsv plain text file might look like this (values separated by tabs):

7 -1.90

POOOOOO0O0OO0
COWO~NOUIAWNER

To use "Quick Data Import", select the menu item from the "File" menu. Corelyzer will popup a file
selection dialog to select the text file in the format described above.

A screen capture video of these actions can be found in this link online (size: 665KB) [http://
www.evl.uic.edu/cavern/corewal l/documents/movies/6.2-L oadDataQuick.mov].
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6.3. Use Custom Data Import

6.3.1.

In the case your data file is not in Corelyzer dataset XML schema yet, you can use the “Custom Data
Import” feature under “ File” menu to specify few parameters and have the program to convert your datafile
into Corelyzer dataset XML format. A user can convert a plain text tabular datafile or a Geotek generated
data (after pre-processing and data cleaning) to Corelyzer XML data format and directly imported into
Corelyzer working session.

Import parameters:

File name: Original input file name. Use "File..." button to select your input file.

Field Separator: Input what is used to separate each fields in the input file. Commonly used separator
might be comma(,) for CSV file. Or Tab(typein \t) delimited file.

Section Prefix: The prefix used for naming each section

Start Line Number: In the input file, the starting line number of data values, starting from 1.
End Line Number: In the input file, the ending line number of data values

Fields Label Line Number: What is the line number for labels of each value in columns.

Unit Label Line Number: What isthe line number for units of each value in columns. If thereisno such
line, just input the same line number as"Field Label Line Number"

Name Column Number: Which column field should be picked used as the name of section. The final
section name will be composed with "Section Prefix" and "Name Column Number". A simple comma
separated expression is allowed to compose the section name.

Depth Column Number: Which column will be treated as depth values. Column index starts with 1.

Select Value Columns: From previous inputs, the field labels will be identified. Then you can check
which fields do you want to select to the final dataset file.

A step-by-step walkthrough example

Next is a step by step walkthrough example. The example source data file is downloaded from IODP
L og database at Lamont-Doherty Earth Observatory, ColumbiaUniversity [http://iodp.ldeo.columbia.edu/
DATA/]. The data file used in this example is 763B-ngt.dat [attachments/763B-ngt.dat]. The resulting
Corelyzer dataset file is output_data.xml [attachments/764B-ngt.xml].

Select the "Custom Data Import" from the "File" menu.
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Figure6.1. Select " Custom Data Import"
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The selected file will be loaded into "Plain Text Data Import" dialog. The upper half of the dialog shows
different dataformat parametersin tabs. Thelower half shows the content of the text file with line number
attached to the beginning of each line.

In the "File Info" tab, the selected file will be shown and you have to select from one of the available
separator (comma, tab or space). In the this example, tab separator is selected.
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Figure 6.2. Dataimport - fileinfo

@~ e Texpaaimpon ]

infe Data Ramge  Field & Unit Label  Depth Setup  Fields Selection
input file name and field separator

T63B-ngt.dat File...

Field separator: + COMMA
linejnumber SPACE

7618
122 '
- 134 0610005
OM: T4 853027

SGR CGR THOR URAN POTA
34,0610 2.7477 2.5013 0.3589 0.0278 0.0747
34.2134 2.74FT 2.5013 0.35849 00278 00747
34,3658 2.TATT 2.5013 0.358% 00278 0.OoF4T
34,5182 2.7477 2.5013 0.2589 0.0278 00747
34,6706 2.TATT 2.5013 0.35849 o.0278 0.0747
14 8210 2.747T 2.5013 0.3589 00278 00747
34.9754 2.74FT 2.501% 0.3584% 00278 00747
151278 Z.7477 2.5013 0.3589 00278 00747
15. 2802 L.7477 £.5013 03589 00278 LOr47
354326 2.747F 2.5013 03589 0.0278 0.0747
15. 5850 2.74TT 25013 0.3589 00278 00747
35.7374 2.747F 25013 0.35849 00278 00747
15.8898 2.747T 2.501% 0.358% 002 T8 00747
36.04.22 2.7477 25013 0.3589 00278 0047
36,1946 2.7T4T7T 2.5013 0.3589 0.0278 0.0747
16,3470 2.TATT 2.5013 0.3589 0.0278 00747
16 4994 2.TATT 2.50113 D.3589 0LD2TR D.O747T
36.6518 2.74TT 2:.5013% 0.3589 00278 00747
I6.8042 2.T4TY 2.5013 0.3589 0.0278 0.0747
16,9566 2.7477 2.50113 0.358%9 00278 00747
17, 10950 2.TATT 2.50113 0.3589 0027E 00747
17.2614 2.7477 2.5013 0.3589 00278 0.0747

2.TATT 0.0747

2.74T7 47

( Cancel 3 ( Back ) ( Next ).

Because sometext fileswill have certain number of comments linesin the header to describe the datafile.
In the "Data Range" tab, you can specify the actual dataline range. Notice that the first number in each in
the lower "File Content" panel shows the line number starting from one. In this example, the actual data
starts from 6th linetill the very end of the file (line 1586). In some equipments, bad or invalid values will
be recorded during data acquisition with some fixed numbers like -999.99. If you want to ignore these bad

values, check the "Ignore some bad values?' checkbox and type in the designated value.
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Figure 6.3. Datarangetab

-

! FileInfo ~DataRange | Fitld & Unit Label  Depth Setup  Fields Selection |
| Start Row and End Row

Stam Line Mumber:

Ernd Line Number:

1 Ignore some bad walue?

File Content
1 HOLE:

6 3340610
7334.2134
B 334.3658
T 334.5182
10 334.6706
11 334.8230
LZ 334.9754
133351278
14 335.2802
15 335.4326
16 335.5850
L7 335.7374
18 33586898
19 336.0422
20 336.19486
21 336.3470
22 336.4994
23 3366518
24 3368042
25 336.9566
26 337.1090
27 337.2614
28 3374138 2.5013
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Cancel I Eack 3 (

Next, you need to specify the lines showing the labels for fields and units. If the data file does not have
the unit label line, just select the same line as the field label. In this example 5th line shows the labels
for datafields.




Load and Plot Numerical Log Data

Figure 6.4. Field and Unit Labels

! File Info  Data Range - Field & Unit Label - Depth Setup  Fields Selection
~Label and Unit Row
Fields Label Line Number: 5l
Unit Label Line Number: 5
File Content
1 HOLE: F)LE ] .
2 LEG: 122
i TOP 334061005
4 BOTTOM: §74,853027
5 DEPTH SGR CCR THOR URAN POTA
6 334.0610 2.7477 2.5013 0.3589 0.0278 0.0747
7334.2134 2.7477 2.5013 0.3589 0.0278 0.0747
8 334.365% 2. 7477 1.5013 (.3589 00278 0L.OF47
9 334.5182 2.7477 2.5013 0.3589 0.0278 0.0747
10 334.6706 2.7477 2.5013 0.3589 0.0278 0.0747
11 3348230 2. 7477 25013 L3589 0.0278 LOFaT
12 334.9754 2.7477 2.5013 0.3589 0.0278 0.0747
13 335.1278 2.1 2.5013 L3589 00278 0LoFa7
14 335.2802 2.7477 2.5013 0.3589 0.0278 0.0747
15 335.4326 2.7477 2.5013 0.3589 0.0278 0.0747
16 335 5850 2.7477 2.5013 0.3589 0.0278 0.0747
17 335.7374 2.7477 2.5013 0.3589 0.0278 0.0747
18 335.889%8 27477 25013 0.35489 0.0:78 LOFa7
19 336.0422 2.7477 2.5013 0.3589 0.0278 0.0747
20 336.1946 2.7477 2.5013 0.3589 0.0278 0.0747
21 336.3470 2.7477 2.5013 0.3589 0.0278 0.0747
22 3136.4994 2.7477 2.5013 0.3589 0.0278 0.0747
£31 3366518 2.7477 2.5013 (.35489 00278 Quoray
24 336.8042 2.7477 2.5013 0.3589 0.0278 0.0747
25 336.9566 2.7477 2.5013 (1.3589 00278 00747
26 137.1090 2.7477 2.5013 0.3589 0.0278 0.0747
27 337.2614 2.7477 2.5013 0.3589 0.0278 0.0747
283374138 27477 25013 0.3589 00278 uorar 7
29 337.5662 2.7477 2.5013 0.3589 0.0278 0.0747
i!iiii!'i i ilii ilili A AFEAS i e e 1, 1 ﬁl'_ﬁ::ﬂ'-.
( Cancel I Back Y ( Mext )

Next, depth information parameters have to be specified. Y ou have to specify which column means depth.
In this example, the depth isin the first column.

In the "Depth Mode" selection, you can select from either "Section Depth” or "Accumulated Depth".
"Section Depth" means the depth val ues are measured from the beginning of each section that the dataare
acquired from. "Accumulated Depth" means the depth is measured from the bottom of the sea/lake floor.

51



Load and Plot Numerical Log Data

Because internally Corelyzer arranges depth values into sections, it in one way fits how certain parties
obtain the data from sections of cores. In the other way, it helps renderning performance. So if the
"Customize Section Name" is not checked, the data will be put into sections suffixed with section
numbers automatically. If your datafiles has section information embedded (like datafiles from LacCore
repository), or you have your own section naming convension, you can customize your section nameswith
"Section Prefix" and "Name Column Number".

For example, if you have a datafile looks like this:

Ceot ek MSCL Version 3.0 - GLAD4-HST03-1A QUT created at 12:37:15 on 08-21-2003.,,,

SB DEPTH , SECT NUM , SECT DEPTH, ST , PWAND , PW/el , Denl , MB1
m . , Cm , Cm . ,m's ,gm cc , Sl
0. 06, 1H 1, 6, 6. 605, 50, 130. 9347, 1. 2618, 82. 5908, 165. 2135, 0. 8632

0.07,1H 1, 7, 6. 605, 50, 131. 1427, 1. 1873, 89. 2873, 155. 7109, 0. 9064

0.08, 1H 1, 8, 6. 605, 50, 130. 9736, 1. 2688, 95. 0648, 166. 1739, 0. 8592

.41, 1H 2, 92, 6. 604, 50, 130. 9019, 1. 5467, 152. 7585, 202. 4669, 0. 698
2.42,1H 2, 93, 6. 604, 50, 131. 1098, 1. 5654, 152. 2331, 205. 2369, 0. 6871
2.43, 1H 2, 94, 6. 604, 50, 130. 9408, 1. 6787, 148. 03, 219. 8154, 0. 6214

N

4.41, 2H 2, 20, 6. 605, 50, 5436. 214, 1. 9546, 271. 8012, 10625. 5, 0. 4614
4.42,2H 2, 21, 6. 605, 50, 130. 9477, 2. 0751, 287. 0326, 271. 7301, 0. 3915
4.43,2H 2, 22, 6. 606, 50, 130. 9545, 1. 9434, 300. 9818, 254. 4949, 0. 4679

Each section’'s name can be composed by prefix "GLAD4-HST03-1A" with suffix from the string in the
"SECT NUM" column. So check the "Customize Section Name" checkbox with "GLAD4-HST03-1A"
section prefix and the number "2" in the "Name Column Number" will give the sections named "GLAD4-
HST03-1A-1H-1", "GLAD4-HST03-1A-1H-2" and "GLAD4-HST03-1A-2H-2". Also notice that you
need to use values from multiple columns to compose your full section name, you can also fill in string
like, "2,-,4,-, 7" to have values from multiple columns in the full section name separated by "-".
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Figure 6.5. Depth setup
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T 3342134 2. 7477 2.5013 0.3589 00278 0.0747
8 334.3658 2. 7477 2.5013 0.3589 0.0278 00747
9 334.5182 2.7477 2.5013 0.1589 0.0278 0.0747
10 334 6706 2. 7477 2.5013 0,.3589 00278 0.0747
11 334 B230 2. AAFT 2.5013 0.3%E9 00278 00747
12 334.9754 2.7477 2.5013 0. 3589 0.0278 0.0747
13 335.1278 2. 7477 2.5013 0.3589 00278 0.0747
14 335 2802 2.ra7T 2.5013 0.3589 00278 0.0747
15 335.4326 2.T4TT 2.5013 0.3589 0.0278 0.0747
16 335.5850 2.7477 25013 i0.1%89 00278 0.0747
17 335. 7374 2. 7477 2.5013 0,159 00278 0.0747
18 3315 ERGE 2.7477 2.501% 0. 1589 00278 00747
19 3360422 F.TATFT 2.5013 03589 00278 00747
20 336.1946 2. 7477 2.5013 0.3589 0.0278 0.0747
21 336.3470 2. 7477 2.5013 0.3589 00278 0.0747
22 336 4904 2. 7477 2.5013 0.3589 00278 0.0747
23 3366518 2. 7477 2.5013 0.3589 00278 0.0747
24 336. 8042 2.7477 2.5013 0.3589 0.0278 00747
25 336.9566 2. 7477 2.5013 0.31589 00278 0.0747
26 337, 1090 27477 2.5013 0,.3589 00278 0.0747
2T 337 2614 2. TAFT 2.5013% 0.3%E9 00278 0.0747
28 337.4138 2.TAFT 2.5013 0.3589 0.0278 0.0747 "_
29 337.5662 2. 7477 2.5013 0.3589 00278 0.0747 =
PR T oA
I s L1
{ Cancel 3 Back 3 (

)

In the "Fields Selection” tab, you then can select the data field columns that you want to import into
Corelyzer.

53



Load and Plot Numerical Log Data

Figure 6.6. Fields selection
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17 335.7374 27477
18 3315 8898 2.1477
19 336.0422 27477
20 336.19485 2.1477
21 336.3470 2.7477
22 336.4994 2.7477
23 136.651& 2.1477
24 3368042 2.7477
25 336.9566 2.7477
26 337.1090 2.7477

Cancel

The data import process will then ask you to save the converted file (in Corelyzer native xml format) to
your disk for future use. After saving, the data will be loaded into current Corelyzer session.
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Figure6.7. Save converted file

Save As: | 763E-ngt.xml

| [l Deskrop

# 20
[
-
.

B crDownloader-data Friday, Jaruary 9, 2009 208 PM
Ll Dis-Interep Wednesday, December 3, 2008 5:18 PM

& Gereratelist Maorday, February 2, 2009 5:34 PM

File Formar: | XML file {xml) ]

Comee) @)

Notice that just like core images, data plots have to belong to atrack grouping. So if you haven't have a
track created or you want to have dedicated track grouping for data graph plots, create a new track from
the "File" menu.
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Figure 6.8. Createatrack for data graph plot

Please input the track name

Graph Track|

[ Cancel ] E—OH

A screen capture video of these actions can be found in this link online (size: 6.7MB) [http://
www.evl.uic.edu/cavern/corewal l/documents/movies/6.3-L oadCustomData.mov].

6.4. Download from IODP-USIO logging
database

The Integrated Ocean Drilling Program, United States Implementing Organization provides the logging
database accessing service described in the webpage [http://brg.Ideo.columbia.edu/services/].

Toload logging datafrom the IODP-USI O logging database, select the"IODP" meun item from the "File"
menu and then select "Show IODP lists...". Then clicking on the "Logging DB" tab in the popup window
as shown in the following figure.
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Figure 6.9. Logging DB tab in |ODP tables window
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Then depending on where do you run the program, you can choose to access the on-ship version
or the Internet version of the service. On-ship version will use the service provider URL "http://
loa.ship.iodp.tamu.edu/serviced [http://load.ship.iodp.tamu.edu/services]" and the Internet version will
use the service provider URL "http://brg.ldeo.columbia.edu/". Once the service provider is selected, the
available site and tool options will be downloaded and populated in the sel ectable combobox options. Or
you can also type in interested site and tool and then click on the "Search" button to search for available
data. The search result will be shown in the table rows below. Y ou can use mouse to highlight multiple
rows and click on the "L oad selected datafiles' button to download, convert and load the data files. Then
follow the "Plot dataset graph” steps to show data plots of these |oaded data files.
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A screen capturevideo of these actions can befoundinthislink online(size: 6M B in 1920x1200 resol ution)
[http://www.evl.uic.edu/cavern/corewall/documents/movies/L oadFromL oggingDB.mov].

6.5. Plot dataset graph

If you have dataset files loaded and tracks created, your main iCores control window should like the
following screenshot.

Figure 6.10. Main window with dataset loaded

eno. . s

File Edit Share Plugins Lists Tools Help

Status
My Core Repository Main Panel
m Session Track Sections Data Files Fie
v subscriptions [Deraun —— Wllcrapn Track |l (76 38-raz v
SAFOD holeC
SAFOD all T TFO
Leg 199, Site1215 Wl

Leg 19%, Siteldlb
Leg 199, Sitel256

(0] (o] (]

Use mouse cursor to right click on the interested data file entry and click on the "Graph..." menu item will
bring up the "Graph Dialog" below.
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Figure 6.11. Graph dialog

Choose a dataset:
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Y ou can select section by section and the available data fields will be shown in the "Propertiesfields' list

below. Check on the interested field checkboxes will plot the graph plot in the main visualization area
registered to the depths.
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Y ou can also check the "Apply to all sectionsin this dataset” to apply field selections to all sectionsin a
dataset file. When you select afield, thefield's maximum and minimum valueswill be updated below. Y ou
can change the viewing maximum and minimum values to scale the graph plots. Y ou can also change the
plot presentation and colors in the options below. If the "Collapse Graphs' option is checked, all checked
graph plots will be fit into a single drawing box. Otherwise, each graph plot will be shown in individual
box/row in the main visualization area as shown below.
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Figure 6.12. Graph plot without graph collapse
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In some cases, you might want to amplify the actual scale of the graph plots when you are looking data
plots in great depth range. To increase or decrease the graph (vertical) scale, you can first click on the
visualization canvas area, and then press [' or ']' to decrease or increase the graph's vertical scale on the

screen.

A screen capture video of these actions can be found in this link online (size: 2.0MB) [http://
www.evl.uic.edu/cavern/corewall/documents/movies/6.4-GraphParameters.mov].
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Chapter 7. Interactions

7.1. Interaction Scheme

7.1.1.

7.1.2.

The basic interaction scheme is a mouse-based interaction. The application is best run using a two-button
mouse with ascroll wheel. Inthe most recent version of Corelyzer, the mouse clicks and events are context
sensitive. Thismeans, depending on what your mouse pointing to, the response of the application to mouse
events can vary.

Panning

To automatically begin panning using the Click-and-drag style, first left-click on the visualization window,
making sure not to click on any objects (e.g. core section images, graphs, annotation markers, etc.)

If you successfully clicked and are in the panning-mode, then the mouse pointer should change. In
Windows, it will likely change to a four-direction pointer. On Mac OS X, it will change from a black
mouse to a white mouse cursor. To pan, keep holding down the left mouse button and drag the mouse to
move the view of the scene.

Zooming

If you have a mouse wheel, zooming is as easy as scrolling the wheel back to zoom out and forward to
zoom in. Assuming a particular areais of interest and you want to zoom in on it, simply point at that area
of interest and use the mouse wheel to zoom in. The areawill stay in the same place as the scene changes
in scale. Similarly, you can zoom out to see more of the context that surrounds a particular area.

Y ou can aso use keyboard for navigation in Corelyzer. Y ou can use the four-direction arrow key to pan
around the main visualization area. To zoom in and out around the mouse cursor position, you can press
the"+" and "-" keys. If you want to jump to a certain depth directly, first click on the main visualization
area and then press the "j" key to bring up the "Jump to..." dialog. Input the depth in meter and the main
visualization areawill jump to designated depth directly.
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Figure 7.1. Jump to depth dialog

Input

Please input a depth value in meters:
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Ir Cancel “‘ | OK ]
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7.1.3. Sliding a section

To dide a section image, first left-click on the section image, the image will be highlighted by a yellow
bounding box. If you successfully do this, the mouse pointer will changeto ahand pointer. The core section
image will also be brought to the front of the other images. Thisis noticeable if any of the core section
images overlap. At this point you can slide the section image left or right by moving your mouse left or
right with Alt key pressed at the same time.

7.1.4. Sliding a track

A track can be dlid vertically. To do this, first select a core section image, and then hold down the Shift
key. The mouse pointer will remain looking like a hand cursor. Move the mouse up or down and the track
will be moved in the direction of the mouse motion.

NOTE: Corelyzer loads all images and tracks at the origin. It is recommended to slide atrack away so that
new images on a different track do not overlap an existing track.
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7.2. Graph Plots

7.2.1.

1.2.2.

Graphs can be created after loading datasets that follow the Corelyzer Data XML Schema or plain text
imports. Y ou can select to show it asline graph, points, or cross points.

Aside from creating agraph only track shown in the last chapter, you can a so create graphs by first right-
clicking on a section. When you do this, a pop-up menu will appear. Select the "Graph" option. At this
point the application will show a dialog window similar to Figure 7.10.

If thereis data for the selected section in a given datafile then the fields will show up as selectable items,
as seen in theimage. Otherwise, thelisting of fields will be empty. At this point ssmply click on the check
boxes of thefieldsyou would like to be drawn for the section. If you would like al theimages on atrack to
display the samefields, just make surethat the“ Apply to al sectionsin thisdataset?’ checkbox isenabled.

If you do not have pre-defined section imagery available, you can till plot the dataset with the
“independent graph” feature. To do so, after you load the dataset filesand it is shown in the “ Dataset” list,
right click on the dataset file that you want to plot, select “Graph...”, the similar graph dialog will show
up and the heuristic graph section will be created and plot the graph in visualization screen(s). Notice that
you will need to create at least atrack for it (as shown in the last chapter).

Graph plot properties - scaling

The three properties of a graph that can be changed are: minimum value, maximum value and the color.
The minimum and maximum displayed values can be modified. This will take affect after you hit the
Apply button. If you havethe “ Apply to whole track?’ checkbox enabled, all the sections on the track will
have their minimum and maximum values modified. Thisis how you can make sure that the scales of al
the graphs for a particular field are the same along awhole track.

In some cases, you might want to amplify the actual scale of the graph plots when you are looking data
plots in great depth range. To increase or decrease the graph (vertical) scale, you can first click on the
visualization canvas area, and then press'[' or ' to decrease or increase the graph's vertical scale on the
screen.

Graph plot properties - colors

To modify the color of a graph, first select the Color button on the dialog. At this point a color selection
dialog will open up. Select the desired color and press OK. The color of the graph will immediately change.
The change the color of all the graphs of the same field along a single track, make sure that the Apply to
whole track? checkbox is enabled and click on the Apply button.
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Figure 7.2. Adjust graph plot properties

[ e par & of .

¥ ! k &7
Iri ! i
. i g .'ﬂl‘ ' e W
¥ ] "1.' b i _ i
300.00 &m ] 0.00am =S5V i7s U s

66



Chapter 8. Annotation

Annotations are currently shown using amarker along the top of acore. The marker isasimpleinteractive
visua to indicate that an annotation exists. Different markers can mean different types of annotations.
Annotations types will be added as development continues.

Figure 8.1. Annotationsfor coreimages

8.1. Creating new annotations

Currently, text and image annotations are supported. Annotations comein theform of HTML and property
list XML files.

First an image must be loaded. A user can then select "Create annotation mode" to start creating
annotations.

Figure 8.2. Select create annotation mode

‘f&?%ﬁt&ﬂ}fix

Create annotation mode Help

Once you are in creating annotation mode, you can create a region of interest rectangle by pressing-and-
dragging to show interested region. A dialog asking for which kind of annotation you are creating will show
up once you rel ease the the mouse button. Currently Corelyzer supports the following types of annotations.
* Freefrom: athreaded discussion freeform annotation.

 Clast: astructured annotation which keeps track of clastology information.

» Sample Request: afront-end annotation for sample requests.

e Property Vaues: a generic property-value pairs annotation. Default properties is defined in the
dictionary file specified in the preferences panel.
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Figure 8.3. Select annotation type
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8.2. Reviewing and editing existing annotations

After an annotation is created, it can be edited in the future. To edit an annotation, or review it, a user
simply clicks on an annotation marker. The same dialog used when creating an annotation will display.

Currently, the commentswill be attached into adiscussion thread-like display in afreeform annotation. By
clicking thetool buttons at the top of the editing area of annotation window, the user can do simple HTML
formatting and insert images and attachment files with URL s or by selecting files from local hard disk.
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Figure 8.4. Review and edit a freeform annotation
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Any time after the marker is created, the user can change to marker manipulation mode by clicking icon
at the toolbox in the upper left screen. Next, select the marker icon and then by click-and-drag the green
box to change the region of interest.

Figure 8.5. Modify annotation marker mode
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Figure 8.6. Modify region of interest and marker position

A screen capture video of these actions can be found in this link online (size: 14.0MB) [http://
www.evl.uic.edu/cavern/corewall/documents/movies/8.1-CreateM odA nnotation.mov].

8.3. Measuring Mode

Switch to measuring mode by click the measurement icon in the toolbox at the upper left corner. To
measure, click two points on the visualization screen, the physical length measurement will be calculated
and saved to measuring history. The last value will also be copied to system’s clipboard so you can easily
paste to other applications or the annotation.
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Annotation

Figure 8.7. Enable measure mode

Hra- @%éllfallﬂ}éﬁr _+_><

Measure mode Help

Measure History
|7[ Measurei@ 3m 28.6cm H

Point0 (328.59,6.26)
Pointl (331.93,10.38)
Distance: 5.31 cm
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Figure 8.9. Measure on images
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A screen capture video of these actions can be found in this link online (size: 5.7MB) [http://
www.evl.uic.edu/cavern/corewall/documents/movies/8.3-M easure.move].
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Chapter 9. Save and Load Sessions

You can save your current working session by selecting “ Save Session As ...” under “File” menu. This
function will save al the information that you loaded into the sceneinto a XML-based “CML” file. CML
file schema description can be found in here [ http://instaar.col orado.edu/%7Ejenkinsc/dbseabed/corewal l/
CmIXml_Syntax_1.pdf].

Thisfile doesn't save all theimages and dataset fileswith it, it keepstrack of where all therelated filesare
located. Y ou canlater |oad everything back by selecting “ OpenaSession File” under the same*“ File€” menu.

The“cml” fileissmall, and if the resource you loaded into the scene are all downloaded from the Internet
within Corelyzer, theseresources’ URL will be kept and by passing just the*cml” file around, other people
can load back the same session that you were working on.

But if the resources you loaded in your working session are al filesin your local hard disk, and you want
to pass the working session to your colleague? Please use the “Export...” and “Import...” functions under
“Core Archive” menu in the "Fil€" menu. The “Export...” function will pack all the resources along with
asession “cml” file into a big compressed “Core ARchive’, a“.car” file. It will contain al the images,
datasets, annotations and their attachments within. The other people can just use “Import...” to open it up
and restore everything you were working on his’her screen.
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Chapter 10. Corelyzer server and
plugin clients

Corelyzer server and plugin support was devel oped by Arun Rao, Y u-Chung "Julian" Chen and Sangyoon
"James" Leein 2006 for supporting ANDRILL MIS Project.

10.1. Server setup

Before starting the server, a few things must be prepared. First, the machine will need to have the Java
Runtime Environment (JRE) 1.5 or greater. Second, a web-server must be running. Third, configuration
fileswill need to be made.

Setting up the JRE and a web-server are beyond the scope of this document, but many resources are
available on the Web to do so.

The server program requires two files. Thefirst file contains the server settings and is specifically named
“server-settings.txt”. Thisfile contains only four lines and are as follows:

<t he base web address for all annotation pages>
<the directory where the annotations are placed in the server for access>
<the directory where the annotati ons are backed-up to>
<the last tine that the server performed a backup>

<"backenabl ed" or "backupdi sabl ed" to enable or disable data backups>

Here is an example of that file:

http://131.193.77. 222/ ~cor ewal | DB/ annot at i ons
/ Users/ corewal | DB/ Si t es/ annot ati ons
/ Users/ corewal | DB/ Si t es/ annot ati ons
1155613264194
backupenabl ed

NOTE: The second last line should be 0 when first starting the server. After which the server will
automatically update that line every day.

The second file needed by the server isnamed “ users.txt.” Thisfile containsalisting of tuplesthat identifies
aunigque user. Thetupleis (user name, real name, password). The first three lines of the file describe the

user name, real name and password for the administrator of the server.

NOTE: It should be stated that permissions to this file should be setup so that only the administrator has
read and write permissionsto thefile.

An example of the file can be asfollows:

adm n
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10.2

10.3

10.4.

adm ni strat or
adm n

arun

Arun G Rao
nmel odr @mt 1c
j ason

Jason Lei gh

t h3bo55

Anytime anew user is going to be created, it is as easy as adding the user name, real name and password
to the end of thefile.

Running the server

To run the server you will need to perform the following command:
java —cp CorelyzerSessionServer.jar corelyzer.plugin.andrill.CorelyzerSess

After running that command you can logout of the server machine and the server program will continue to
run. To properly shutdown the server, use the “ server-shutdown” command available to the admin client.

Running the administration client

Y ou can run the admin client from anywhere. Simply have the JRE 1.5 or greater and keep a copy of the
CorelyzerSessionServer.jar file. To run the client simply run the command:

java —cp CorelyzerSessionServer.jar corelyzer.plugin.andrill.CorelyzerSessi onAdm

Where you would replace the |.P. 192.168.1.1 with the proper hostname or 1P of the machine running the
server. Following isadetailed look at the set of administrator commands.

Administrator commands

» Command: "new-section". Arguments: "Section name",
meters’.

Starting depth” in meters' and "Length in

Purpose: The main purpose of the command is to notify to the server that a new core sections exists.
Effectively creating empty slots of split-core image and whole-core image entries. Thisis also used so
that when a new data comesin, there are correlations to depth intervals and section names.

e Command: "new-missing-section”. Arguments; "Section name prefix", "Starting depth in meters' and
"Length in meters".

Purpose: The main purpose of the command is to notify to the server that a new missing core
sectionsexists. Effectively creating empty slots of split-coreimage and whole-coreimage entries. Using
command like “new-missing-section andOO1 0.0 1.5” will create a new section with section name
“and001_0.0-1.5-missing”.
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Command: "new-split-core”. Arguments: "The URL to the image file", "The name of the section the
image comes from", "The DPI (dots-per-inch) of theimagein X (horizontal) direction" and (Optional)
"The DPI of theimagein Y (vertical) direction"

Purpose: The purpose of thiscommand isto let the server know the web address of the split-core image
that was created from the core section. This will let the server then notify the clients that the image
exists and is available for download and viewing in Corelyzer.

Command: "new-missing-split-core". Arguments: "The section name of missing split core"

Purpose: The purpose of this command is to assign a empty split core image to a core section due
to there might be no split core image available but users still need to access the data and whole core
images. The missing section name convention will be like <prefix>_<start_depth>-<end_depth>, eg:
“and001_186.7-187.5".

Command: "new-whole-core". Arguments: "The URL to the imagefil€", "The name of the section the
image comes from" and "The DPI (dots-per-inch) of the image".

Purpose: The purpose of this command is to let the server know the web address of the whole-core
image that was created from the core section. This will let the server then notify the clients that the
image exists and is avail able for download and viewing in Corelyzer.

Command: "new-dataset". Arguments: "Data file to parse” and "The name of the dataset to append/
overwrite".

Purpose: This command will parse atab-delimited datafile and feed the server new datatables. Thetab
delimited data file must follow the formatting exampled in Appendix B. This command will retrieve
alisting of sections to use the depth and length of the sections to determine how to partition the data
fileinto tables.

Once the tables are created the tables are sent to the server and stored in afile with the following name
convention:

dat aset. <secti on nane>. <dat aset name>.tab

If the dataset name does not exist in the server, it will be created automatically. If the name exists then
the files created on the server will automatically be appended.

NOTE: Existing fileswill be overwritten automatically! If thisis an undesired effect, please make sure
that there are no rows that contain depths of sections that would previously had a table made for them
for the dataset. If you are only appending to a single tab-delimited file without changing previous rows
then the overwrite will effectively be doing nothing for previously created tables.

Command: "list-sections'. Arguments: None

Purpose: The purpose of thiscommand isto list the existing sections known to the server. Returned isa
listing of section names, their depth and length in meters. The output is displayed to the command-line.

Command: "list-datasets’. Arugments: None

Purpose: The purpose of this command is to display datasets known to the server. Displayed are the
names of the datasets followed by the attributes in the dataset and their respective minimum and
maximum values within the whole dataset.

Command: "list-tables’. Arguments: "The name of the dataset”
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10.5.

10.6.

Purpose: This command will display alisting of tables within a given dataset. Thisis useful if you do
not know if a given section is covered by a dataset because the names of the tables are the names of
the sections.

e Command: "list-table-data’. Arguments: "The name of the dataset" and "The name of the section/table
toview"

Purpose: This command will display the data of atable from a given dataset. The data is displayed in
atab-delimited form with the first line as the header followed by lines of numerical values. Table cells
that are invalid will appear blank.

e Command: "run-backup”. Arguments; None

Purpose: The server runs backups automatically if the last backup has occurred more than 24 hours ago.
This command forces the current day’ s backup to occur.

e Command: "logout". Arguments: None
Purpose: This command allows the administrator to logout and ends the client program.
e Command: "server-shutdown". Arguments. None

Purpose: This command allows the server to properly shutdown.

Admin commands reference table

Table 10.1. Commandsreferencetable

Command Arguments

new-section section_name> depth_in_mbsf length_in_meter
new-split-core image_url section_name image_dpi
new-whole-core image_url section_name image_dpi
new-dataset dataset file dataset_name
list-sections

list-datasets

list-tables dataset name

list-table-data dataset_name table_name
run-backup

run-script script_file

logout

server-shutdown

Client plugin in Corelyzer

In the client side, a client plugin is provided in Corelyzer software. To activate the client user interface,
select "Collaborative Corelyzer” from the "Plugins’ menu.
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Figure 10.1. Activate client plugin
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To connect to the session server, you can either select or type in the server name from the drop down menu
on the top of the client plugin user interface and click on the "Connect” button. The interface then will
prompt to ask for the user name and password for accessing the server.
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Figure 10.2. Connect to session server
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After logging in, the user interface will display available split core and whole core section images and
numerical datasetsfor plotting. To load the available images, click on the checkboxesin each section row.
The client plugin will start downloading and loading the section images in the background and show in
the main visualization canvas.
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Figure 10.3. Main session client plugin user interface
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10.7. Example dataset file

The basic formatting of thisfileis simple. The first row will contain unique column headers that are tab-
delimited (i.e. separated by tabs). The first column of the data, by default, is assumed to be the column
that contains the depth reference for the datain the row. Every row of datais also tab-delimited, and must
contain the same number of tabs as the header row; in order to positively determine which data value
belongs to which column. Microsoft® Excel can export a worksheet as a tab-delimited file in the same
way. An empty entry is considered to be two consecutive tabs, and will be dealt with properly. Any data
that appearsto beinvalid should be deleted in your spreadsheet program of choiceto create an empty entry.

Depth [m Porosity [%vol] WBD [g/ccn] Sus [units]
12.250 0.454 1.937 241.46

12.270 245.60

12.290 0.420 1.995 244.68
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10.9.

12. 310 0.408 2. 015 257.45
12.330 0.365 2.087 280.15
12. 350 0.387 2.050 305.97
12.370 0.383 2. 057 390. 86
12.390 0.434 1.971 620. 38
12. 410 0.282 2.226 762.53
12.430 0.376 2. 069 644.55
12.450 0.441 1.959 435.98

NOTE: In this example you can see that on the third row there are two blank entries for both Porosity
and WBD columns.

Handy scripts

Table 10.2. Handy scripts

Script name Function description

startserver.sh Server startup script

adminlogin.sh Interactive administrator client startup script
import_img.cron Sample script that can be placed in crontab to import

section image summary report

import_data.cron Sampl e script that can be placed in crontab to import
dataset summary report

img_summ Section image summary report example file (tab
separated fields in each line)

CRP Dataset summary report example file. Notice that
the data’ s depth must be within the range of sections
existed in server

Some notes

» Convert raw scanned image files from BMP or TIFF to JPEG files, to reduce file size and save some
network transmission time.

e The server assume the splitcoreimages arein ‘vertical’ orientation and it will tell clients to rotate them
so images will be layout horizontal way.

» Beforeimport the dataset, make sure the data arein the range of sections already availablein the server.
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Chapter 11. Fine tune with Correlator

11.1. Before start - Download Corrlator and
Corelyzer

You have to download and install Correlator and Corelyzer. The latest version of Correlator can
be downloaded from here [ http://sglcore.geo.umn.edu/CoreWall Database/cwWiki/index.php/Correl ator],
and the latest version of Corelyzer can be downloaded from here [ http://www.evl .uic.edu/cavern/corewall/
downloads.php].

11.2. Interaction flow

In the following section, we will show step-by-step how to connect to Corelyzer from Correlator to use
available core images assisting choosing tie points in creating affine tables.

11.2.1. Start Corelyzer

Double click on the Corelyzer icon to start Corelyzer. Y ou might want to properly setup the visualization
area of Corelyzer if you do not want it overlaps with Correlator's data plot window. Please refer to
Corelyzer Display Configuration section for setting up Corelyzer visualization area.

11.2.2. Start Correlator

Double click on the Correlator icon to start Correlator. Please refer to Correlator documentation for start
using Correlator.

11.2.3. Load log data tables and image list table

Before using the fine tune function, you have to make sure you have loaded both the data table and the
image table of the cores. Please refer to Correlator document on "How to load data files into Correlator
Data Manager".

In the following example, 3 data files (Bulk Density GRA) and a image list data file are loaded into
Correlator's Data Manager.
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Fine tune with Correlator

Figure 11.1. Example data and image list files are loaded in Data Manager in
Correlator
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Figure 11.3. Theimagelist file format loaded in Correlator
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11.2.4. Load log data into Correlator plotting area
Right click onthelog dataentries and select "L oad" to load the datainto the plotting areain the Correlator.

Figure 11.4. Right click on the data entriesand click on the " Load" toload thelog
data into the plotting area of Correlator
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The data will be plotted in the Correlator window. In the following screenshot, it shows a 1920x1200

screen with Corelyzer showing in the left half and Correlator showing the right half with log data loaded
and plotted.

Figure 11.5. Side-by-side Corelyzer and Correlator with log data plotted
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11.2.5. Connect to Corelyzer from Correlator

Click onthe"Connect to Corelyzer" button on the Correlator command window as shown in the following
screenshot.
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Figure 11.6. " Connect to Corelyzer" button in Correlator command window
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A confirmation dialog will popup asking whether you want to unload previous|oaded imagesin Corelyzer.
Click on "YES" will unload previous tracks and imagesin Corelyzer.

Figure 11.7. Confirmation of unload previously loaded imagesin Corelyzer
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After successfully connected, if the user use the scrollbar in Correlator to change the viewing depth range,
the view range will also be updated accordingly in the Corelyzer visualization area.

11.2.6. Composite depth shifting with core images

Core images will be loaded in the Corelyzer side, if the connection between Correlator and Corelyzer is
established during choosing both 2 tie points (red and green points) in Correlator. A red horizontal line
will appear in the Corelyzer asthe reference tie depth.

Figure 11.8. Creating 2 tie pointsin Correlator
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Dragging the green tie point in Correlator like you always do, it will update/shift the core images
accordingly like the data plots segments. Y ou can use the core image texture for correlation reference.
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Figure 11.9. Adjusting tie points also updates cor e images
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If you right click the (green) tie point and select the "Clear" option, the core images will be placed to their
original position. After your adjustments, right click on the (green) tie point to choose adjustment option as
described in Correlator document. The core images will be positioned using the result affine table. If you
click onthe"Undo To" button in the Correlator, the affine table will be restored and re-read by Corelyzer
to shift core images according to the affine table.

When you disconnect from Corelyzer, adialog will popup in Corelyzer main window. By default selecting
"YES" it will close all opened core images during the composite session. If you want to keep the
arrangements setup on screen, you can save the session file as described in the " Save and L oad Sessions’.
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Chapter 12. Frequently Asked
Questions (FAQ)

12.1. How do | compare two cores?

To compare 2 coresimages or dataside-by-side, you can arrange coresto be comparedin different "tracks”.
To do that, first create and highlight a new track. Then load first batch of images to be compared using
"Load images' itemin the"File" menu. The second batch of coreimages can beloaded into another newly
created track using similar steps. To arrange them side-by-side, use keyboard+mouse gesture " Shift-Drag"
one track away from another in the vertical direction. If you need to move individua section along the
depth direction, you can use "Alt-Drag" gesture to move sections to different depths.

12.2. More question...

More description...
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Appendix A. Appendix
A.1l. Why is the Image DPI Important?

Corelyzer is a system that intends to bridge core imagery from multiple sources and scale as time moves
on and resolution improves. To do this, the system scales all the images so that these varying resolution
imagery can map to a space that will indicate what the dimensions of these images actually represent. In
other words, so that an image of a 1.5-meter section appears to be 1.5 meters in length despite how high
of aresolution image you take. Does this mean that getting higher resolution imagery is a bad idea? No,
because you can always zoom in to see the finest detail available on the image. The higher the resolution
theimageis (i.e. the higher the DPI), then the more details that can be seen.

A.2. Making Sure the DPI of an Image is Correct

Here we will discuss about how to make sure a core image has the correct DPI. At this point, let's assume
that your digital-line-scanner scans the core at 100 dots per centimeter. Thisis equal to 254 DPI.

The first thing to do is open the image in a program like Adobe Photoshop, or The Gimp. At this point,
we will assume that you are working with Photoshop.

In Photoshop, you will want to view the image's properties by going to Image -> Image Size. A dialog
will appear showing the image width, height, etc. If the resolution does not match the expected DPI then
we will need to change it. Before doing that make sure that the Resample Image checkbox is unchecked.
Otherwise, when you change the DPI of the image, the image will get resized. After you uncheck the
Resample Image option, edit the Resol ution text field and enter the correct DPI. At thetime of thiswriting,
most core section images have a DPI of 254.

If you realize that more than one image contains the wrong DPI, you can create a batch process in
Photoshop to help you deal with al the images.

A.3. Corelyzer Data XML Schema

The Corelyzer DataXML Schemaisafairly smple XML schema. It isbased off of aversion of the Geotek
data XML format. Examples are available at Sample Data.

The root of the Corelyzer XML Schemais >corewall_data<. Inside this node are blocks of section tags.
The XML schemaissimply aset of tables, onefor each core section. Inside section tags are tagsto identify
which section the table belongs to, units of depth, listing of fields and the data retrieved from sensors
at particular depths. Here is a complete example of the XML schema, with sample data processed from
JANUS:

90



Appendix

Figure A.1. Example native Corelyzer data XML file
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-orewal |_data=

<zection:
<1d=1219a_B18h_B3< id=
depth_unit=cm- depth_unit=
field localid="1" nome="HALC" unitz=""/ =
<field localid="2" name="H3IG" unitz=""/=
<depth=3.679=/depth=
<zenzor id="B8"=88.15= zenzor=
<Eenzor id="1"=36.67< zenzor>
<depth=&.768-= depth=
<zenzor id="B8"=83.73< zenzor=
epth=13.839< depth=
<zenzor 1d="B"=83.522< zenzor=
<zenzor id="1"=37.Z21l= zenzor=

</zection:

</corewal | _datax
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